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Starting LEAR
LEAR is the literature management part of DDBSP.

A fresh installed LEAR only contains a single database. It's the “DDBST” database containing all references for 
the DDBST data banks.
The second database shown here is another “DDBST” database suffixed by a “/p”. This database contains all 
private references for customer-created data banks. Section  The File Menu describes how to create a private 
literature database.
LEAR handles also other – non-DDBST user-specific databases – they must not have the name “DDBST”.
The status line

displays the number of available datasets, the data and time of the latest write access of the database under the 
mouse cursor. In addition always the folder of the Dortmund Data Bank is displayed.
When the mouse cursor is over a database icon the full path to the database file is displayed as hint. This also 
true when the option “Display Hints as Popup” in the “Global” part of the options menu is turned off.

The Tool Bar
The tool bar

contains shortcuts to some functions.

Create a new and empty literature data bank (library)

Close a data bank 

Append a new and empty data set to a selected library

Import a PCP tagged file (import of pure component properties files)

Import another LEAR data bank 

Search in library or libraries

Change display mode of data bank list

Create a private library (only active if there is currently none)

Show About Dialog
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The Menu Bar

The File Menu

New Library

“New Library” creates  a new personal  literature  database.  If the  “private  DDB” 
literature database does not exist it can be created using the first option. The second 
option creates a user specific database which can't be associated with experimental 
data like VLE.

The database is always created in the “LITERAT” sub folder of the private DDB folder. 

This location is indicated by the “/p” suffix.

Open

“Open” opens the currently selected data bank and displays  the complete list  of entries.  The same happens 
when an icon is double-clicked.

Close Library

“Close Library” is closing the database file stream but does not close any open result list.

Load Setnumbers

“Load Setnumbers...” allows to load a file  (STX format)  that contains dataset  numbers. These files can be 
created in LEAR – representing a search result – or in the main data bank retrieval program – containing all 
references of datasets in a query result.

New Dataset

“New Dataset” allows to enter a new dataset. This is described later in detail.
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Import

“Import” allows to add datasets from other files and formats.
The  “REF”  format  is  an  old  DDB format  which  has  been  superseded  by 
LEAR, “PCP Tagged Files” are exchange files for pure component properties, 
“LIDA”  is  the  predecessor  of  “LEAR”  and  now deprecated  and  “Import 
LEAR” allows to import other LEAR data banks.

Delete Library

“Delete Library” allows to remove the selected database files – only the main “DDBST” library cannot be 
removed. A removed database can not be restored.

Rename Library

“Rename Library” allows to change the name of a data bank. The standard DDBST library – both private and 
public – cannot be renamed.

Extras

The “Extras” sub menu contains some utility functions.

Rebuild Index

“Rebuild  Index” recreates  the  LEAR indexes  for  a  faster  search.  Normally  the  index  is  kept  up  to  date 
automatically.

Duplicate Search

“Duplicate Search” allows to find duplicate entries.
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The “Duplicate Search Options” dialog allows to fine-tune the criteria.
The result of this search is a list with the duplicate entries which can be printed or copied.

Retrieve Keywords

“Retrieve Keywords”: Currently the list of available keywords is stored in the user specific part of the registry. 
This functions adds all used keywords of the selected database to this list.

Update Ref Files

“Update Ref Files” exports all literature datasets of the selected library to *.ref files of the associated DDB 
folder. This function is only available for the DDBST and DDBST/p database. Only datasets with links will be 
exported.

External Links Settings

The external links facility allows to connect scans, data files, PDFs etc. pp. with a reference in the literature 
database. Use the “External Links Settings” dialog to configure the folders where the associated files reside.
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The folders can contain files of any type. The files must start with the associated literature dataset number. A 
leading  “L”  is  as  well  allowed  as  leading  zeros.  Example:  “1234.pdf”,  “L1234.pdf”,  “001234.pdf”  and 
“L001234.pdf” will all refer to dataset number 1234.
The external link settings are database specific. The usage of external links is described in section Displaying
Externally Linked Files and Folders on page 30.

Exit

“Exit” closes LEAR and all open result windows.

The Edit Menu
“Search...” opens the search dialog. Searching is described later in detail.
“Journals...” opens the journals list. This dialog is described later in detail.
“Options...” displays the “Global Options” dialog.
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Global Options Page

Hints are short descriptions of buttons. LEAR allows to display these short help strings either as small pop up 
windows at the mouse position or as strings in the status bar at the window bottom.
The color options are for displaying two special literature types.

“Ordered Literature” are articles and books that are in the process of being procured, “Exhausted Literature” are 
articles  and  books  that  cannot  be  procured,  mainly  because  they  are  to  old  (19th century  for  example). 
“Translation Available Literature” are articles which are available in another language. This applies mainly for 
Russian articles where an article translated to English is also stored. 
The colors are used as background color eithers in the single dataset edit dialog or in the search result grid.
The “Enable External Links” box has to be checked to associate external files to a dataset.
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Result Window Options Page

Since sorting of larger search results is rather slow and memory-consuming LEAR allows to display a warning 
if the search result is larger.
“Remember Sort-Links-String” describes the behavior of sorting a result grid by links.
The options “Save Window Position” and “Save Window Size” are related to the search result window whereas 
the “Save Dataset Display Window Size and Position” is related to the details window which can be opened in 
the search result.
With “Use Multi-Line Cells” turned on the cells in the result list expand vertically to fit to the text in the cells.  
Otherwise all cells have the same hight. This is for example useful to see the complete title in the result list.
Multi-Line Cells turned off:

Multi-Line Cells turned on:

Datasets which status indicates that the articles are currently not available can be marked with a special color in 
the result list. Use “Status Color” mode to modify the behavior.
With “Keep Horizontal Scroll” is turned on the result list does not jump to the first column when the keyboard 
is used to navigate through the list. The option can lead to some flickering effects.
Turn “Independent Window” on to have all result windows displayed in the Windows status bar. This option 
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will only take effect for windows opened after the option change.

Import Options Page

Since LEAR allows to import  literature  information from multiple  sources it  is a  major  task not  to import 
duplicates.
The import options allow to fine-tune the search for duplicates.

Environment Options Page

The environment options are only displayed as an additional information. 
The entries displayed here can be modified in the DDB configuration program.

The View Menu
The  entries  “Normal,  Small  Icons”,  “List  View”,  and  “Detailed” change  the 
display of the libraries.
Normal View:

Figure 1 "Normal"

Detailed View:

Figure 2 "Detailed"
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“Arrange Icons” sorts the list of libraries and “Refresh” rebuilds the list.
“Close All Result Windows” closes all result windows.

The Help Menu
“LEAR Help” displays this paper.
“Tip of the Day” displays some useful hints for the work with LEAR.
“Development News” shows new tips for this version.
“About LEAR” displays detailed program version information.
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Searching
The search can be started from the  button in the main window.

LEAR has implemented two search query modes – one simple and one complex. The simple search query is 
easier to handle but offers less options. It is possible to start with the simple query and copy the conditions to 
the complex query to refine the search conditions.

Quick Search

Available Fields are
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Authors Several names can be entered.  The single names have to separated by spaces. Only references 
where all names are given will be found (“And” relation). It is possible to specify that the word(s) 
can match anywhere in the authors list (substring), can only match as full word (whole word). The 
other options are not very useful and only for completeness.

Years A single year or a range of years has to entered. Any year must be specified with all four digits. A 
“/” can be used to define a continuous range, use “;” to separate single years. Example: To search 
for all literature published from 1980 to 1982 or in 1986 use “1980/1982;1986”.

First Page A single number has to be entered. Normally “exact match” is preferred, but its also possible to 
allow a match as “prefix”, “suffix”, or “substring”.

Journal A list of numbers denoting the DDB journal numbers separated by blanks can be entered. Use the 

 button to select journals from the list. See below for details.

Volume Since volume can contain letters this search allows also a substring search. A search for “12” will 
also find “123” and “12A”. In addition all options as for “First Page” are possible.

Title Several words can be entered. The single words have to separated by spaces. Only titles with all 
words available will be found (“And” relation). Use “whole word” to find full words only.

Numbers A range of dataset numbers can be specified (format as in “Years”). In most cases this field is not 
used in combination with the other options. Therefore the field is marked slightly yellow when the 
contents is not empty (to avoid unexpected search failures).

The “*” denotes the fields for which LEAR has indexes.  These searches are much faster  than non-indexed 
fields. The author index is no exact index.

The “Clear” button will empty all edit fields. The additional options are not touched.
The  “Copy  to  Adv.  Search” button  copies  the  current  quick  search  settings  to  the 
advanced search settings. The advanced search page is active afterwards.

The “Libraries to be Search” control contains all available literature databases. Only the selected databases are 
searched.

Advanced Search
The advanced search allows to search in almost all data fields (“Field” column). The “Mode” column contains 
options specific for the selected data fields. The “Operator” column allows (together the “String Mode” column) 
to change the behavior of the search. The “Words” columns contains the search text or number.
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Search Fields

String Fields
String  Fields are  “Authors”,  “Comment”,  “First  Page”,  “Keywords”,  “Language”, 
“Last  Page”,  “Location”,  “Place/Inst.”,  “Title”,  “User  defined  Number”,  “Volume”, 
“Issue”,  “Report/Patent  No.”,  “First  Editor”,  “Last  Editor”,  “Series”,  “Book Title”, 
“Series Name”.
For  String  Fields the  mode  column has  two options:  “must  contain”  or  “must  not 
contain” and the operator  column allows to search for “all”  or  “any”  words  in the 
words column. In addition it is possible to specify if a text must match as “substring”, 
“whole  word”,  “prefix”,  “suffix”  or  “exact  string”.  The  “Words”  column  accepts 
words  separated  by  blanks.  To  search  for  text  containing  blanks  enclose  them in 
quotation marks.

Number Range Fields
Number Range Fields are “LEAR Number” and “Year”. It is possible to specify either 
one number and search for all which “is equal”, “is lower or equal” or “is greater or 
equal”. Or you can specify a number range (see quick search dialog for details).

Date Fields
Date Fields are “First  Edit  Date” and “Last  Edit  Date”. The “Words” column only 
accepts one valid date. Click on day, month, or year to change it. A click on the down 
arrow  brings up a date selection dialog. It is possible to search for dates which are 
“equal”, “lower or equal” or “greater or equal”.

Journal Field
It is possible to search for (“must contain”) or exclude (must not contain) datasets from a list of journals. Use 
the button  to view/edit the selected journals. See section Selecting Journals on page 
24 for details.

Status
The status of an article can be “available”, “missing”, “to be ordered”, “urgent demand”, “in process”, “can't be 
procured”,  “not  ordered”  or  “check needed”.  The  word column presents  a pop up menu with the  possible 
entries.

Links
Links are simple numbers and data bank dependent (separate numbers for VLE, ACT, ...). The mode column 
contains the data banks list (from “aae” to “vle”) and the operator column allows to set the options “equal”, 
“lower or equal”, and “greater of equal”. The words column allows to enter a single number.

Multiple Queries
The advanced search dialog allows to enter multiple search queries.
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 adds a new line,

 removes a line,

 clears all query lines but leaves an empty initialized line (prepared for “Authors” search).
Queries can be combined. 

● Either ALL query conditions must be fulfilled, or
● ANY (one) query condition must be fulfilled, other conditions can be fulfilled.

Use  to load and  to save a query. Queries are saved as INI files in a 
user specific folder.

 A click on the “Search” button will  bring up the search result  window (see next section).  If 
nothing could be found the following dialog comes up:

Click “Yes” to bring up the search query dialog again to refine the search option.
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Search Results
After performing a search a query result window with all matches is displayed.

Tool Bar

Close the search result window.

Close this and all other search result windows.

Copy marked sets to the Windows clipboard in a publication format.

Start email program (MAPI) with a new mail and the selected datasets as text file attachment (more 
than one entry selected) respective as text in mail body (one dataset selected). The default format is 
the publication format. To send the datasets in the display format click on the down arrow to get the 

 menu item.

Open a search query window. A search started from this place will perform a search in the given 
sublist.  To search the full  database either the full  list  must  be active or switch back to the main 
window and start the search from there.
This search doesn't read the data bank but only the grid content.

The search result is not a new query result but the first grid line where the search item has been found 
will be selected.
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Close the search result window.

Search for a data set number within this result list.

This  function  starts  a  search in  the  main  data  bank retrieval  program for  datasets  of  the  marked 
references.
This function brings the main LEAR window to front.

Menus

Results
“Export” allows to save the grid content either as 
comma-separated  files  or  as  an  Excel-  and 
OpenOffice-compatible XLS files. 

“Export Selection” allows to export the marked 
datasets either as a tagged text file or as a LEAR 
library. If an existing LEAR library is selected, 
the marked sets will be appended.

“Save Setnumbers...” allows to store the LEAR dataset numbers only. Private references are stored as negative 
numbers.
“Save Linknumbers” allows to store files containing link numbers. These link number are data bank specific 
ranges of data set numbers. LEAR asks for a folder where it will create several “???_links.stx” files where “???” 
stands for a data bank short term (“vle”, “gle”, etc.). 
See above for a description of “Search for Data of Selection” and “Close Window”.

Edit
“Copy  Selection” allows  to 
copy the marked lines either in 
a publication format  for  use in 
text  processor  or  in  a  grid 
format for use in spread sheets.
“Email  Selection” allows to send 
the  marked  datasets  either  in 
publication or display format (see 

above).
“New Dataset” opens the edit dialog and allows to enter a new dataset. This option is only available if the full 
list is active.
“Delete Selected Datasets” allows to remove datasets from the database. This command actually deletes the 
datasets in the database. It is not recoverable. Only references that are not used in the DDB can be removed.
Use “Rename Result Window” to give the result list a meaningful name. It is not possible to have two windows 
with the same name. Only the text between the brackets in the window title will change. Renaming the window 
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makes it easier to identify a specific search result when switiching between them using the “Windows” menu 
entry or the task bar entries (“Independent Window” turned on)

Search

The search functions have been explained in the tool bar section.

View
“Detailed  Display” opens  a  child  window  with  a  detailed  text  view  of  the 
currently selected reference. The contents updates automatically when a different 
dataset is selected.

The text in the “Dataset Display” window can be printed and copied. It is possible to turn word wrap on an off 
and to set the window always on top.

Options
“Sort Links By” allows to select the sort mode if the datasets shall be 
sorted  by  the  database  links.  Normal  mode  is  simple  sorting  by 
alphabetical  order.  Since  a  reference  might  contain  multiple  links  a 
reference with “aae[34];vle[34]” will be sorted by the “aae” entry. The 

“vle”  link  will  not  be  used  because  it  is  on  second  place.  This  can  be  prohibited  by 
choosing the “vle” link as basic sort criterion.
“Edit Options” displays the “Result Window” page of the global options dialog.
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Windows
The “Windows” menu can be used to switch between several this is useful if “Independent Window” is turned 
off.

Grid Functions

Sorting
The grid allows to open an edit window for single set by double-clicking its line. Editing single sets is described 
in details elsewhere.

The grid allows to sort its content by clicking in the first row.
A second click on the same column reverts the sort order.
Shift-click allows to sort by more than one criterion, like sort first by date and second by 
pages.

Column Moving
It is possible to change the order of the columns. This is done by clicking on the 
heading of  a  column,  holding down the  left  mouse  button  while  moving the 
mouse cursor along the heading to the left or to the right.

Context Menu
The context  menu of the grid repeats several of the functions of the tool  bar and the menu.  The following 
functions are unique.

“Change Color of ...” allows to select another background color for a 
column.
A column can be removed from the result list. The only column that 
can't be removed is the “Number” column.
Use “Insert column” to insert a hidden column into the result list. The 
column will be inserted before the column below the mouse cursor.
“Remove Selection” allows to remove datasets from the search result 
list. This does not modify the database.
“Create  New  Window  from  Selection” opens  a  new  search  result 
window with only the selected sets.
“Common Properties” opens  an  edit  window which  allows  to  edit 
common properties of the selected data sets.
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These “common” properties have to be the same in all selected datasets before editing, the different entries are 
inactive  and  cannot  be  changed.  The  only exceptions  are  “Keywords”  and  “Comment”.  If  the  entries  are 
different it is possible to choose to “append” a value to all selected datasets or to “replace” the value in all  
selected datasets by the specified value. “None” will leave the entries unchanged.  The changes here modify 
the database.
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Journals
The journal's editor can be started from the “Edit” menu of LEAR's main window.

LEAR uses an underlying journals list and provides an editor for this list.

Stored Fields
The most important fields in the journals list are
• a journal number
• a journal short name
• the CAS source index
• the ISSN number
• a description of the type if the reference is not a journal.

Editing
The single entries are editable after selecting the “Edit” button.
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The “Monography Type” can be easily changed by choosing one item from the drop-down list. An empty field 
means “Journal”.

Changed entries are marked red until they have been saved using the “Save” button.

“Append” allows to add new journals.

An empty row is appended to the journals grid and the grid is automatically in edit mode. By pressing the 
“Save” button the new journal can be used in the literature data bank.

Searching
Searching for journals allows to combine queries by simple logical operations.

Search String Result
eng&chem All journals containing “eng” and “chem” are listed.
eng|chem All journals containing either “eng” or “chem” are listed.
eng&chem&!trans All journals containing “eng” and “chem” but not “trans” are listed.

Searching is always restricted to the currently listed journals. To search all journals the entire list can be made 
visible again by pressing the “Clear List” button.

Selecting Journals
The journals dialog is in selection mode when it is called from a search query window.

In this case the dialog hides the “Edit” and “Append” buttons and activates the “Select” button.

To select a single journal mark the grid line and press the “Select” button. It is also possible to select all marked 
journals by selecting one of the drop-down menu entries.
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Editing Single Sets
The editor for single sets can be called by double-clicking a line in a search result or by adding new datasets  
from the main window.

List of Fields
The list of fields changes with the type of paper (monograph, article, etc.). In the following the most important 
fields are described.
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• Literature Kind Defines the type of paper stored.

Figure 3

The drop-down box shows the complete list of possible entries. 
Changing to another type changes the dialog controls, because 
the different types need their special descriptions.
A list of these special controls is given in the following 
list.

 

• Precise Kind
This list  contains a list of a more precise description of the reference kind. This lists 
aren’t complete and always contain an entry which can be used if nothing else matches 
(e. g. “monograph” for books).

• Dataset Number A unique number specifying the data set. This number is automatically created by the 
program and cannot be altered.

• User defined 
Number

This is a freely definable number useful when another literature list has been imported in 
a LEAR library. It allows to keep the original numbering.

• Title The title of the paper.

• Authors The  authors  of  the  article.  Each  author  has  his  or  her  own  cell  and  the  naming 
convention (for DDBST) data banks is family name followed by space and initials. The 
initials are not separated by blanks.
The order of the authors can be changed by dragging the title bar to a different location.

The context menu allows to delete a cell, merge two cells or 
insert a cell.
Press RETURN in the last cell to append a new cell.
The authors check function is also available (see below).

• Pages First page and last page of an article are stored in different fields. In case of an article 
from a book the first and last page should be used to denote the important pages.

• Year Normally articles have only one year whereas data collections may have been published 
over a period. If there’s only one year given, this year should be entered in the ‘to’ field.
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• Place A text field for further information on the authors, their institute or company.

• Viniti Code
A “Viniti” is a specifically Russian and Ukrainian document type. It was and is  common 
practice in the USSR and its successors that articles have been published only with their 
title and abstract. The rest of the paper with the experimental data are available from 
central libraries near Moscow and Kiev.

• Patent No. Patent number, only used for patents.

• Report Number Report number, only used for reports.

• Journal The journal list is a separate file.  LEAR only stores a number which is an index to the 
journal in the journals file.

The journal can either be selected using the   button next to the journal name, by 
double-clicking in one of the grayed journal fields or by simply typing in the journal 
number left from the journal name. The journal selection dialog is described in section 
Selecting Journals on page 24.

• ISSN International standard series number of a journal. This field belongs to the journal entry 
and can only be modified in the journal editor.

• Volume Volume of an article

• Issue Issue number of an article

• Series Series number or letter of an article

• Book Title In article from a book “Title” contains the title  of the article.  “Book Title” can then 
contain the title for the whole book.

• ISBN International standard book number (for books only)

• Edition Edition of a book

• Editor Editor of a book

• Publisher / 
Place

Name of the publisher (for book) or the place (for conference and thesis)

• Language The original language of the paper (Chinese, Japanese, German, etc.)
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• Keywords LEAR manages keywords not as pure text, but as special list. This decision has been 
made for getting keywords organized.

The list contains mostly short terms for the different DDB data banks.

• Entering Date Date of incorporation. This field is filled automatically and cannot be altered.

• Location A text field for defining the location of the paper.

• Status A  short  list  of  comments  where  the  paper  is  currently  in  the 
working queue.

• Comments This a a place for unstructured additional information.

• Links Links  are  used  to 
assigning  an  article  to  a 
data bank.
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Tool Bar
Close the edit dialog

Copy dialog content to the clipboard (tagged format)

Paste dialog content from the clipboard (tagged format)

Copy dialog content to the Windows clipboard – either in publication format or in display format

Print dialog content

Start main data bank retrieval program and display all datasets from current reference.

Show external links (see below for details)

Font selection (see below)

Special Command Buttons

The eyeglasses button besides the authors allows to check the authors names order. The Google button starts 
a search in the registered web browser by submitting a search URL like 
“http://www.google.com/search?q=Wilson%20R.Q.%20Mink%20W.H.%20Clegg%20J.W.”

The   button calls a simple function for converting the title in uppercase/lowercase 
text. This function is far from perfect.
Right-click on the button to get a menu which allows also to convert all to uppercase or 
all to lowercase.

Font Selection
The single set editor allows to change the font of the dialog's controls.
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Here's an example where the font is changed from Lucida Console

to Arial.

Displaying Externally Linked Files and Folders
The external  links  facility  allows  to  connect  scans,  data  files,  PDFs  etc.  with  a  reference  in  the  literature 
database. The dialog which displays the linked files and folders can be directly displayed from within the single 

dataset editor. If the connection symbol  is enabled there are files associated with the current dataset.

The link display dialog displays the linked files and folders. Double-click on a filename to load the document 
into the registered application. Double-click on a folder name to see the full folder contents.
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Section External Links Settings on page 7 describes how to configure the folders for external files.
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Appendix

The Usage of Links
The motivation for creating the Dortmund Data Bank was to have experimental data for fitting parameters for 
correlation and prediction models. This lead to the conclusion that only originally published values are useful to 
have  in  the  data  bank  and  that  lead  to  the  conclusion  that  the  data  sets  have  to  be  referenced.
 LEAR 

VLE 12 AZD 5 

VLE.REF 

VLE 12 

AZD.REF 

AZD 5 

VLE.DDB 

Ref. No. 12 

AZD.DDB 

Ref. No. 5 

Link Link 

In earlier days these references have been stored in separate lists for every data bank. This caused problems in 
adding references  (multiple  copies  of  a  single  paper  had  to  be  stored  if  a  single  paper  contained  data  for 
different data banks) and searching (several files had be searched). 
To  overcome  these  problems  a  new and  unified  literature  management  has  been  introduced  called  LEAR 
(Literature Excerption, Archiving, Retrieval). All single reference lists are still existent because the data banks 
still have their own numbering system (ranging from one up to their respective highest available number) but the 
references are now in one list and the old numbers are included in this list (see Figure 1).
The new management makes it easier to find references, no duplicates are introduced anymore and there’s only 
a single place for editing and adding reference information.

The Data Bank Structure

LEAR has been designed to support multiple libraries, two of these libraries have special meanings. The DDB 

Literature Page 32 of 34

 DDB.CFG 

Public Folder 

Public folder 
location location 

Private folder 

Private Folder 

Public Literature 
Folder 

Private 
Literature Folder 



DDBSP - Dortmund Data Bank Software Package 2009

system supports two data banks, a public and private data bank. These are normally located in two different 
folders. LEAR uses this organization and supports a private and a public literature data bank.
A private data bank is intended for use by our customers to store company owned data and literature. The public 
data bank is distributed by DDBST GmbH.

LEAR tagged format
The tagged format (ASCII) is used for example when a single dataset is copied to the clipboard. The defined 
tags are:

Tag Meaning
SET: Data set number
CLA: List of links in the format DDB-short-term (HE for mixing enthalpies in the example) followed by the 

link number in square brackets. If there are more links each are separated by blanks.

AUT: Authors
TIT: Title

DCL: Journal class
JRC: Journal number (from the DDB journals list)

JRN: Journal short name
JCS: Journal code (CAS source index)

JLT: Journal long name
LNG: Language

PNR: Patent number
YEA: Year

PGE: First and last page separated by blank
VOL: Volume

SER: Series
ISS: Issue

PLC: Place
BTI: Book title

EDI: Edition
ISB: ISBN

SNA: Series name
ENA: Editor name

CMT: Comment
UDN: User defined number

KWD: Keywords
EDA: First edit date
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Tag Meaning
CRE: First editor

LOC: Internal location
STA: Status

LDA: Last edit date
LED: Last editor
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